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1. Start your browser and navigate to http://streaming.discoveryeducation.com/ 
2. Enter your Username and Password. If you have not registered contact Janetta Garton to 

obtain the passcode for your building.   
3. Click the blue GO button. 
 
 
 

 
 

You can access Streaming from home.
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Keyword Search 

·  Type exactly what you’re looking for in the keyword search box. Results will match 
EVERY word in your query.  

·  Use quotation marks for specific results. If you type "Kennedy Assassination," results 
will be those words only in that order. 

·  Target your keyword searches with conjunctive searches. Capitalize the following 
words or use the appropriate symbol: 
�  AND or + 
�  NOT or – 
�  OR 
 
Examples  

�  AND: civilization AND China  
�  NOT: revolution NOT industrial  
�  OR: deaf OR "hearing loss"  
�  Quotation marks: “black holes”  
�  Combination: German AND military NOT Japan  

·  You can use the Within: drop down box to select a specific media type such as: full 
videos, video segments, images, articles, audio, quizzes, events, lesson plans, or 
clipart.  

 
 

 
 
 

·  By clicking the “Advanced Search” link right below the keyword search box you can 
focus on a specific media, subject, grade, publisher, etc. 
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Advanced Search 

  
 

Notice the 
Explore All Titles 

button. 
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Search Results 
After the clicking the Search button the results are listed in a menu on the left “Narrow My 
Results.” Possibilities include Full Videos, Video Segments, Images, Articles, Audio: Songs, 
Audio:Sound Effects, Speeches, Quizzes, Events, Lesson Plans, and Clip Art. Click on any 
of these links that have results identified in parenthesis. 
 
 
 
 
 
 
 
 
 
 
Full Videos 
 
 
 
 
 
 
 
 
 
 
 
 
Images 
 
 
 
 
 
 
 
 
 
 
 
Clipart  
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Video Description Page 
Click on the video title to access a full description page.  
 

 
 
 
 
 

 
 

 
 
 
 
 
 
 

Generate a printer friendly 
page that include video 
information. 
Email a link to this page to 
other unitedstreaming users. 

Click the drop down arrow for 
the Add to box and choose to 
add this video to you’re my 
Content page, quizzes or 
assignments. Click the ADD 
button to complete. 
 
Share your opinion of the video 
with the unitedstreaming 
community by choosing a 
rating. 

·  Play is disabled during the school day, to protect our 
network, but is available after school hours. 

·  Download: DO NOT USE THIS DURING SCHOOL 
HOURS FOR A FULL VIDEO. THIS WILL 
COMPROMISE OUR NETWORK. 

·  Download Later: click this to set the video to be 
downloaded after school hours to the Network Manager. 
Email Scott Wooldridge (swooly@willard.k12.mo.us) to 
let him know you have requested this video. Allow 4-5 
school days for this process:  
1. Tech personnel, will check the Network Manager on 

a regular basis. Any downloaded videos will be 
burned onto a DVD and sent through school mail to 
the appropriate teacher. The downloaded file will 
then be deleted from the Network Manager. 

2. Once you have used the DVD for your lesson, please 
send the DVD to the library to be cataloged and 
available to all staff members for future use. If at any 
time your building discontinues their Streaming 
subscription, these DVDs will no longer be 
available, per copyright restrictions. 

Media Settings 
·  choose to enable closed 

captioning if appropriate 
·  select Windows Media Player or 

QuickTime 
·  set your player as embedded, it 

plays within the webpage; or 
stand-alone which opens a new 
window with only the video. 

If you set a video to be 
downloaded to the Network 

Manager, and tech staff knows 
that is has already been burned 

for your building, you will 
receive an email. 



5/27/2008 http://www.willard.k12.mo.us/co/tech/unitedstream.htm p 8
  5/27/2008 

Video Segments 
Click the Video Segments tab. Videos are divided into segments so you can show the parts 
that best relate to your objective. 
 

 

 
 

 

 Play is disabled during the school day, to protect our network, but is available after 
school hours. 

 Download: It is okay to download video segments during the school day. 

 Download Later: It is not necessary to use the Download Later option for video 
segments. You can use the Download button for a video segment. 
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Downloading 
After clicking the download button the File 
Download window will be displayed. Click Save 
and navigate to where you want to store the video. 
 
I would recommend saving your download videos 
to the My Videos folder nested in the My 
Documents folder. Video files are very large. One 
minute of video requires 1.8 MB of storage. If 
you frequently download videos keep an eye on 
your hard drive space. You can do this by opening 
My Computer and clicking one time on your C: drive to select it. In the pane on the left you 
will see Free Space as well as Total Size for your hard drive. 
 
I would recommend saving images/clipart in the My Pictures folder nested in the My 
Documents folder. 

 
Citations 
Citation information is provided for videos, 
video segments, images, and articles. By 
clicking on the Citations tab you can view 
MLA, APA, and Chicago Manual of Style 
formats. Citations may be copied and pasted 
into projects that include unitedstreaming 
content. 

 
 
 
 
Related Materials 
Click on the Related Materials tab to access 
available resources including: 

·  Curriculum Standards for Missouri 
·  Blackline Masters: worksheets, 

quizzes, word searches, crossword 
puzzles, and other classroom tools 

·  Teachers Guides: objectives, 
discussion questions, lesson plans; 
Many contain the full script of the 
video program. 

·  Quizzes: use to test comprehension or survey prior knowledge. Quizzes can be 
printed or accessed by students through the Student Center. 
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Subject/Grade Search 
·  From the homepage you can choose to search by 

a Subject area or Grade range.  
·  Then use the Narrow My Results box to refine 

your choices. 

Curriculum Standards 
·  You can access the drop down boxes in the 

Curriculum and Standards Search window to 
conduct a search for videos linked to Missouri 
Standards. This search strategy locates only 
videos.  

·  When I used the Curriculum Standards search 
and choose Missouri, Science, and 5th grade, the 
following screen was displayed. The standards 
are list with a description and link if any videos 
meeting this standard are available. 

 

 
 

·  By click the “videos meeting the standard link” a list of videos with description is 
displayed. 
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Hardware Options 
·  Laptop/Teacher Desktop & Projector  

o view a downloaded video clip, writing prompt, etc.  
o view a complete video that you have downloaded after school hours 
o view a complete video that you have downloaded to your station from the 

Network Manager 
o if you have a CD burner, view the video from a CD you have created. Be sure 

to close the CD if you will be playing it in a different computer. 
o if the station has a DVD player: view a burned DVD of the video sent to you 

by the Tech Dept, after you have set the video to be downloaded to the 
Network Manager. 

·  Laptop/Teacher Desktop, Smartboard, & Projector   
o view a downloaded video clip, writing prompt, etc.  
o view a complete video that you have downloaded after school hours 
o view a complete video that you have downloaded to your station from the 

Network Manager 
o if you have a CD burner, view the video from a CD you have created. Be sure 

to close the CD if you will be playing it in a different computer. 
o if the station has a DVD player: view a burned DVD of the video sent to you 

by the Tech Dept, after you have set the video to be downloaded to the 
Network Manager. 

o Choose to use SMART Notebook 9.3/9.5 software and SMART Video Player; 
see the information towards the end of this handout for details. 

·  Teacher Desktop, TV Aviator/Scan Converter, & TV  
o view a downloaded video clip, writing prompt, etc.  
o view a complete video that you have downloaded after school hours 
o view a complete video that you have downloaded to your station from the 

Network Manager 
o if you have a CD burner, view the video from a CD you have created. Be sure 

to close the CD if you will be playing it in a different computer. 
o if the station has a DVD player: view a burned DVD of the video sent to you 

by the Tech Dept, after you have set the video to be downloaded to the 
Network Manager. 

·  TV and DVD Player 
o view a burned DVD of the video sent to you by the Tech Dept, after you have 

set the video to be downloaded to the Network Manager. 
·  DVD Player and Projector 

o view a burned DVD of the video sent to you by the Tech Dept, after you have 
set the video to be downloaded to the Network Manager. 
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Viewing Videos with Windows Media Player 11 
 

·  To play DVDs using the Windows Media Player, you must have a DVD-
ROM drive and a software or hardware DVD decoder installed on your 
computer.  

·  If you currently do not have Windows Media Player 11 on your station you 
can download it at:  
http://www.microsoft.com/windows/windowsmedia/default.mspx 

 
To play a video or segment that has been downloaded, navigate to the file on your computer, 
and double click the file name. Your default media player should start and play the video. 
Assuming Windows Media Player is your default player. See the following directions for 
more details on using this software. 

 
To play a CD or DVD  

1. Put in the CD/DVD. If this window displays, choose Play 
using Windows Media Player and click OK. 

2. If it doesn't, or if you want to play a disc that is already 
inserted, click the File Menu and choose Open. Then 
navigate to the video. 

 

  

If you don’t have a File Menu, right-click on 
the menu bar across the top with Now 
Playing, Library, etc. Choose View>Class 
Menus.  

�

 
 
 
 
 
To watch a video in full-screen mode  

1. To view the video in full screen mode, click the   button in the bottom right 

corner to have the video fill the screen. 
2. To view the video in compact mode, click the  key in the bottom right corner.  
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On-screen controls 
  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

�

Pause: pause the video. 
�

�

Play: play the video. 
�

�
Stop: stop the video  

�

Rewind: press and hold 

�
Fast Forward: press and hold 

�
Sound: click and drag this button to change 
the volume.  
�

�
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This feature allows you to collect, organize, share and retrieve your favorite unitedstreaming 
media resources, assignments, quizzes, and writing prompts in one convenient place. Located 
in the navigation bar at the top of the screen, “My Content” is accessible from anywhere on 
the site. 
 

 
 

·  You can add content to folders you create in My Content, by using the “Add to” drop 
down menu on any media resources page.  

·  You can create sub-folders to create hierarchies 
within content.  

·  You can choose to share folder contents with our school or your district. 
·  This does not initiate a playing or download procedure. The purpose of My Content is 

to bookmark the resource to avoid searching for it again. All files and projects are 
stored on the streaming servers. 

·  Notice the View drop down menu. You can choose All, Quizzes, Folder List, 
Assignments, Writing Prompts, or Media. 
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1. Locate a resource using Search. 
2. Select “My Content” from the “Add to” drop 

down menu and click the ADD button. *Make 
sure to allow pop-ups from unitedstreaming 
when adding material to My Content, or hold 
down the Control key when clicking the ADD button to temporarily allow the pop-
ups. 

3. A pop-up window will open. You may add the resource to the “My Content” default 
folder, or add it to a new folder. 

4. If you select “Add to New Folder,” follow the prompts and enter a folder name and 
folder location. My Content allows you to create folders within folders. 

5. Click on “Add” and the window will display a confirmation message, telling you that 
your content has been added.  

6. Click “Close Window.” 
7. To access your content, click the “My 

Content” link on the navigation bar at the 
top of the screen. 

 
You can also sort your 
resources by type, name, 
creation date, subject, or 
grade by clicking on these 
column labels. Or, use the 
blue arrows to move 
resources up or down the 
list, so that they are 
organized in the way that is 
most useful to you. You 
can access the listed 
resources by clicking on 
their names. 
 
Once you have added 
media resources to My 
Content, you can use the pull down menu under Action to copy, move, share and delete 
them.  
 
If you choose Share, the Share Folder popup 
window will open and you can choose to “Share 
to School” which is your building, or “Share to 
District.” To see what has been shared for your 
School or the District click the appropriate tab. 
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By clicking the Network Manager tab you can see all the videos that have been downloaded 
after school hours. You can download these videos to your station at any time. Playing or 
Streaming videos from the Network Manager could overtax our network. 
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Creating a Hyperlink to a Video Segment 
A hyperlink is a text or graphic element that points to a specified web page or opens a digital 
file that has been saved on a local computer or network server. After you have downloaded 
and saved video segments, you can create hyperlinks using text and images. Users simple 
click the text or image hyperlink to open and play a video segment. Hyperlinking is a simple 
way for teachers and students to lay video files within a separate media player window that 
provides access to player control such as volume, play, pause, and stop. 
 

Creating a Hyperlink in Word or PowerPoint 
1. Download a video segment into a designated folder. 
2. Save your Word or PowerPoint file in the same folder. 
3. Highlight the text or select the image on the page that you wish to use for the hyperlink. 
4. Go to the Insert menu and choose Hyperlink. 
5. Click to select the video file that you wish to link to the text or image in your document.  
6. Click OK.  
�

Embedding a Video Segment 
When you embed a downloaded file, you insert it right into your document much as you 
would a picture or clipart file. Embedding makes use of the multimedia capabilities in 
software such as PowerPoint, and allows teachers to create presentations that do not rely on 
separate media players. Embedding is an effective way to add video content to existing 
presentations, create interactive learning projects with menus and text prompts, or develop 
slide shows in which video files play automatically. 
 

Embedding a Video in PowerPoint 
1. Download a video segment into a designated folder. 
2. Save your slideshow document in the same folder. Keep the folder and file names brief. If 

the full path to a media file exceeds 128 characters, the file will not load and the viewer 
will see a blank white space instead. 

3. Go to the Insert menu and choose Movies and Sound, and Movie from File. 
4. Click to select the video file that you wish to insert.  
5. Select the automatic play option or choose to start the video with a mouse click. 
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When you enable Closed Captioning, the video player will display the audio portion of the 
video as text right below the video image. With Closed Captioning, you can address the 
different learning needs of students and enhance comprehension as students read, listen, and 
view video content. 
 
 

Download a Closed Captioned Video Segment 
1. Check the “Enable Closed Captioning” box, located in the Media Settings box below the 

player window. 
2. Save the video segment. Click the download icon next to the desired segment. 
3. Navigate to the desired location and save the video file. Make sure the file ends with the 

.asf extension. 
4. Download the Closed Captioned Transcript. Click on the CC icon for the appropriate 

video segment and select “Save” from the popup menu.  
5. Navigate to the exact location where you saved the video segment and save the transcript 

file. Make sure the file ends with the .smi extension. 
 

Play Closed Captioning with Windows Media Player 
1. Start Windows Media Player: Click the Start button>Programs>Windows Media Player. 
2. Click on the “Play” menu and select “Lyrics, Captions and Subtitles.”  
3. Select “On if Available.” 
4. Click on the “Tools” menu. 
5. Select “Options.” 
6. Click on the “Security” tab. 
7. Check the box next to “Show local captions when present.” 
8. Click “OK.” 
9. Click the File menu and choose Open. 
10. Navigate to your video file and click Open. 
 
Once you have set the Closed Captioning options in Windows Media Player you will not 
have to do so again on that particular station. 
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Assignment Builder 
The assignment builder is a versatile resource that helps you build online activities and web-
based projects that are store on the unitedstreaming servers. You can use this tool to create 
student assignments that integrate a variety of digital media types. Students access 
assignments through the Student Center. 
 

Creating a new Assignment 
 
1. Click on Teacher 

Center in the navigation 
bar at the top of the 
screen and then click 
the Assignment Builder 
icon.  

2. To get started, click on 
“Create New” from the 
Assignment Builder 
home page.  

3. Notice you can also 
search for existing 
assignments created by 
other users. 
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4. The next window displays 

step 1 of 5: General 
Information. You can Save 
step 1. Make sure to allow 
pop-ups when saving an 
assignment to My Content, or 
hold down the Control key 
when clicking the Save button 
to temporarily allow the pop-
up window to open. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
5. Click Continue to move on to 

step 2: Add Materials. Here you 
can add media to your 
assignments, such as video 
segments, animations, or audio 
files. You can also add an 
activity such as a Quiz or Writing 
Prompt or add links to web sites. 
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6. Click Save and Continue to 
move to step 3: Material 
Instructions. Once you have 
selected media, activities and 
websites for your assignment, 
you can write step-by-step 
instructions that your 
students will see as they work 
with each material type. 

 
 
 
 
 
 
7. Click Save and then Continue 

to move to Step 4: Preview. 
The preview feature allows you 
to see what your assignment 
looks like in its final form. If 
you wish to make changes 
simply click on any of the steps 
in the process chain. 
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8. Step 5: Summary provides assignment information you will share with your students. 
There are two ways you can give your students access to an assignment.� 

A. Provide the Assignment Code: Students will need to go to 
www5.unitedstreaming.com/studentcenter and enter the assignment code, and 
their first and last name in the fields provided. 

B. Provide the Assignment URL: Students are taken directly to 
unitedstreaming’s Student Center. Students simply enter their first and last 
name in the field provided.� 

 
 
 
 

 

 
 
 
 
 
 
 
 

 
 

A 
   B 

 
 

 
When a student completes an assignment, you will receive an email notification. 
You will receive separate notifications for completion of assignments and 
quizzes. The quiz notifications will include the score that the student received on 
the quiz. 
 
You can access all your saved Assignments by clicking the My Content link at the 
top of the webpage. 
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Quiz Builder 
The Quiz Builder tool allows you to create online assessments that you can use to test student 
comprehension or survey prior knowledge. You can: 

·  search over 2,000 pre-made quizzes in the Quiz Library  
·  choose individual questions from the Quiz Builder databank  
·  write your own questions  

Students access quizzes through the Student Center: www5.unitedstreaming.com/ 
 

Creating a New Quiz 
1. Click the Teacher Center link in the navigation bar at the top of the screen.  
2. Click the Quiz Builder icon.  
3. Notice you can use the Search Quiz Library to locate existing Quizzes. 
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4. Click on “Create New” from the Quiz Builder homepage. This will take you to Step 1: 
General Information. 

 

 
 
5. After completing 

Step 1 click Save. 
Make sure to 
allow pop-ups 
from 
unitedstreaming 
when saving a 
quiz to My 
Content, or hold 
down the 
“Control” key 
when clicking the 
Save button to 
temporarily allow the pop-up window to open.  

 
Select where to save your Quiz and click the Save button. You should get a confirmation 
message. Click Continue on the Step 1 page. 
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6. Step 2: Add Materials – You 
can use the Keyword Search 
to add full videos and video 
segments to your quiz or 
search for video content by 
Subject and Grade. 

 
 
 

 
 
 

 
7. After searching by keyword 

you will see a checkbox 
available to “Add to my 
Quiz.” Click the Done button 
when you are finished 
selecting Quiz Materials. You 
will see your selections 
appear in the “Current 
Media” box on the Quiz 
Materials page.  

8. Click the Save button. 
9. Click the Continue button.  
 
 
10. Step 3: Add Questions – The 

Question Databank contains 
thousands of questions you 
can add to your quiz, or you 
can write your own 
questions. Type in a 
Keyword and click the Go 
button.  
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11. The Question Databank 
Search Results appear 
below. Check the box in 
the Add column to use a 
displayed question.  

12. Click the Add Selected 
Questions to Quiz when 
finished selecting 
questions. 

 
 
 
 
 
 
 
 
 
 
The selected Questions will be 
listed in the “Current Quiz 
Questions” window. 
 
 
13. Try each of the options under 

Create New Question. 
 
 
 
 
 
 
Multiple Choice Question (Single 
Answer) 
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Multiple Choice Question (Multiple 
Answer) 
 
 
 
 
 
 
 
 
 
 
 
Short Answer/Essay Question 
 
 
 
 
 
 
 
 
 
 
True/False Question 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
14. Click the Save button. 
15. Click the Continue button. 
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16. Step 4: Preview – The Preview feature 
allows you to see what your quiz looks 
like in its final form. If you wish to 
make changes simply click on any of 
the steps in the process chain. 

17. Click the Continue button. 
 
 
 
 
 
 
 
 
 
18. Step 5: Summary – The summary provides quiz information you will share with your 

students. You can choose between 2 methods:  
A. Provide the Quiz Code: Students will need to go to 

www5.unitedstreaming.com/studentcenter and enter the assignment code, and 
their first and last name in the fields provided. 

B. Provide the Quiz URL: students are taken directly to unitedstreaming’s Student 
Center. Students simply enter their first and last name in the field provided.� 

 
From here you can choose to “Print 
Quiz”or “Print Quiz with correct 
answers.” 
 
 
 
 
 
 
 
 
 
 
 
 
 
You can access your save Quizzes and Assignment by clicking the My Content link at the top 
of any unitedstreaming webpage. 
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 Writing Prompt Builder 
Stimulate the writing process in your classroom with thousands of images that are ready-
made for declarative, persuasive, narrative, and expository writing exercises. You can search 
the Writing Prompt Library for images accompanied by suggested text or create your own 
writing prompts with the help of the Writing Prompt Builder. 
 
 

Creating a New Writing Prompts 
1. Click the Teacher Center link in the navigation bar at the top. 
2. Click the Writing Prompt Builder icon. 
 
 
 
Notice you can Search for 
existing Writing Prompts by 
Keyword. 
 
 
 
 
 
 
 
 
3. Click on “Create New” from the Writing Prompt Builder home page. 
4. Step 1: General Information – Start by providing information about your writing prompts 

in the form provided. 
5. Click Save. Make sure to allow 

pop-ups from unitedstreaming 
when saving a writing prompt 
to My Content, or hold down 
the “Control” key when 
clicking the Save button to 
temporarily allow the pop-up 
window to open. 

6. Choose where to save your 
writing prompt. 

7. Click the Continue button. 
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8. Step 2: Select Image – You can search from over 20,000 high quality, photographic 

images by typing a word or phrase in the Keyword Search or by selecting a subject from 
the drop down menu. Preview an image by clicking on the thumbnail. When you find an 
image that you like, click on the link “Add to my Writing Prompt.”  

 
 
9. Next, select the page orientation and border and then click the “Save” button. 
10. Click the Continue button. 
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11. Step 3: Customize Text – Writing Prompt Builder allows you to select the font type, 

styles, size and color for the title and the caption. You can preview your selections by 
clicking the “Preview” button. Once you’ve formatted your title and caption, click the 
“Save” button. 

12. Click the “Continue” button. 
 

 
 

 
 
 
13. Step 4: Preview – The Preview 

feature allows you to see what 
your writing prompt looks like in 
its final form. If you wish to make 
changes simply click on any of the 
steps in the process chain. 

 
Notice the link for “Click here for 
a printable version.” 
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14. Step 5: Summary – The summary provides quiz information you will share with your 

students. You can choose between 2 methods:  
a. Provide the Writing Prompt Code: Students will need to go to 

www5.unitedstreaming.com/studentcenter and enter the assignment code, and 
their first and last name in the fields provided. 

b. Provide the Writing Prompt URL : students are taken directly to 
unitedstreaming’s Student Center. Students simply enter their first and last 
name in the field provided.� 
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Calendar 
Make history come alive every day by showing video content to your students that presents 
events that occurred on a particular calendar day, week or month in history. The Calendar 
tool is a great way to locate videos that are associated with important events in history, 
prominent people, commemorative events and cultural celebrations.  
 
1. Click the Teacher Center link in the navigation bar at the top of the screen. 
2. Click the Calendar icon. 
3. Calendar events are categorized by subject area. You can customize your display by 

viewing all events for a specific day or choose to view events for an entire week or 
month, sorted by subject.  

4. Click on an event title to view a full event description and a list of resources which may 
include full videos, video segments, articles, and images. 
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Lesson Plan Library 
The Lesson Plan Library has search capabilities and more than 200 lessons designed for use 
with unitedstreaming videos. 
 
1. Click the Teacher Center link in the navigation bar at the top of the screen. 
2. Click on the Lesson Plan Library icon. 
 

 
 
3. Click on a subject area to 

view lesson plans that 
contain descriptions and 
indications regarding the 
recommend grade range. 

4. Lesson plans can be viewed 
or saved in PDF or MS Word 
format. To save a lesson 
plan, click on the appropriate 
format and select “Save.” 
Navigate to the desired 
location. You can change the 
name of the lesson, but must 
keep either the .pdf or .doc 
file extension. 
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Thematic Focus 
Each Thematic Focus provides links to lessons and materials organized around a central 
theme or topic. New themes are added weekly and many focus on seasonal or timely events. 
 
1. Click on the Teacher Center link in the navigation bar at the top of the screen. 
2. Click the Thematic Focus icon. 
3. In each Thematic Focus, you will find a wealth of topic-specific information including: 

·  Resources: A discussion guide and lesson plans organized by grade levels. 
·  Media: A list of downloadable video segments 
·  Activities: Problems, puzzles and worksheets 
·  Events & Articles: Written material that support the theme 

 
 

 
 
 
 
4. Click the “Thematic Focus Archive” link to view a complete list of thematic units 

organized by subject. 
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Atlas 
“Inspired by Discovery Channel's 
landmark ATLAS series, Discovery 
Education streaming provides a 
unique video guide to our world. 
Featuring exclusive clips from 
Discovery's ATLAS series, this 
interactive map provides thousands 
of videos that show off the wonders 
of countries ranging from 
Afghanistan to Zimbabwe. Zoom in 
to each country and learn about its 
culture, government, history, and the 
natural world.”  
 
 
 
 
 
 
 
 
 
 
 
 

Teacher Community 
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Professional Development 
Discovery Education offers a host of staff development options designed to help you make 
the most effective use of unitedstreaming digital resources. Among the options are self-paced 
tutorials, online sessions, and professional development materials. Click on the Professional 
Development link in the navigation bar at the top of the screen. 
 

 
 
·  Teaching Tips: Preview quick, 30-second technology tips – from editing 

unitedstreaming videos to creating hyperlinks – and learn how to infuse your lessons with 
technology. 

·  Trainer’s Toolkit : Use the resources and materials in the Trainer’s Toolkit to enhance 
your unitedstreaming staff development workshops. Download digital versions of the 
User Guide, the QuickStart Guide and other support documents. 

·  Discovery Educator Network: Learn how to become a member of a dynamic 
community of teachers – the DiscoveryEducator Network – and have access to a library 
of Educator Resources, discussions boards, and a variety of training materials. Members 
also have the opportunity attend regional and national events sponsored by Discovery 
education and the Discovery Educator Network. www.discoveryeducatornetwork.com 

·  Best Practices: View short, 30-second video segments that address timely educational 
themes and gain exciting strategies for differentiating instruction, integrating technology 
in the classroom, and communicating with parents. Learn more and watch the video in its 
entirety by clicking on the link that will take you to the full video. 

·  Interactive Training : You can learn online at your own pace with this engaging series of 
lessons. Begin with Lesson 1 and learn how to search, play and download 
unitedstreaming video segments. Additional lessons demonstrate digital media 
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integration, differentiated instruction techniques, and professional development training 
strategies. Print a certificate after the successful completion of each lesson and explore 
professional development credit options with your staff development coordinator or 
administrator. 

·  Project Demonstrations: Project Demonstrations provide exemplary lesson plans, 
multimedia projects, and tutorials that support the successful integration of 
unitedstreaming content with popular software applications. Leverage the software in 
your classroom and learn how to edit unitedstreaming video, embed and hyperlink video 
and images in graphic organizing software or present unitedstreaming content using 
interactive whiteboards. 

·  Course for Credit: Discovery Education is collaborating with several accredited 
universities to offer dynamic, online graduate courses that focus on integrating 
unitedstreaming digital media in the classroom. Course can be taken individually or 
applied to certificate or master’s degree program. 

·  Webinars: A webinar is an online seminar with interactive training elements. Collaborate 
in live, hour-long sessions with a Discovery Education instructor using WebEx and your 
phone. Register for a variety of topics and times each week – all free with your 
unitedstreaming license. Topics range from integrating video and images in PowerPoint 
to using unitedstreaming content to create WebQuests and digital stories. 

 

	�!�������#������
·  You must maintain the original INTENT of the video. With the exception of the video 

titles that have been identified as "editable content," you may not shorten any clip, edit 
sound, or add images within that clip. For copyright reasons, video editing software may 
not be used to edit or integrate streaming videos. 

·  Students are allowed to keep projects containing streaming video clips for their personal 
portfolios. 

·  Teachers are allowed to keep projects containing streaming video clips through the 
duration of the subscription. You personally are responsible for removing all clips from 
storage in the event your school does not renew. 

·  When uploading lessons or projects that integrate streaming video to your school's server, 
you must protect the content. Create a link and stream from streaming servers. 

·  You HAVE permission to share distance learning models with streaming subscribers 
only. You may multicast (having multiple locations view streaming simultaneously) 
across television, as long as you and your end-users are streaming subscribers.  

·  Converting digital video to analog (or taking the video clip from the computer, CD, etc. 
and recording it onto a VHS tape) IS IN VIOLATION OF COPYRIGHT. 

·  Cite all content borrowed.  
·  Faculty may use their unitedstreaming web access at home to stream/download content. 

Students may NOT use the unitedstreaming web site at home.  
·  When modifying ancillary materials, please include the following statement: Revised 

with permission from Discovery Education but Discovery Education is not responsible 
for the content of the revision.  
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To check your computer for the requirements, click the “Check Requirements” link at the 
bottom of the page. 
 

 
 

%��
���
�&	'����(������
·  When using for the first time it is best to hook the projection unit up to your laptop prior 

to turning on your computer.  
·  When your laptop boots up, your computer screen may be blank, as the video output is 

being sent only to the projector. Look at the F keys across the top of your keyboard for a 
monitor icon (F3, F5, or F7). The process varies a little with different computers, but 
basically you hold down the function key and press the appropriate F key on the top of 
your keyboard. You can choose to send the image to both the computer and the projector. 

 

Troubleshooting an LCD Projector 
·  Change the Hardware Acceleration: Start>Settings>Control 

Panel>Display>Settings>Advanced>Troubleshooting Change> the hardware 
acceleration to NONE if it is set on FULL. 

·  Open the plug-in Windows Media Player: On the menu bar, click 
View>Tools>Options>Performance. Look down on the window for “Video 
Performance” >Hardware Acceleration. Change the hardware acceleration to NONE 
if it is set on FULL. 

·  Network buffering in Windows Media Player: In the same location as described 
above, under “Network buffering,” turn buffering on. 

·  Reset Video Resolution: Try resetting the video resolution. Right click on the 
desktop and choose Properties from the popup menu. Click the Settings tab and 
change the Screen Resolution. 

·  Change Overlays: Open Windows Media Player. Go to Tools>Options>Performance 
Tab>Advanced Button>Uncheck “Use Overlays.” 

Troubleshooting the full-screen view�
If you cannot view a video using the full screen, your video hardware may not have sufficient 
memory. One possible solution is to adjust the full-screen settings in the Player. Also, be 
aware that not all visualizations can be viewed on the full screen. 
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1. In Windows Media 
Player, click the Access 
application menus 
button on the title bar 
next to the Minimize 
button, point to Tools, 
and then click Options. 

2. Click the Performance 
tab. 

3. Click Advanced, and in 
the Video Acceleration 
area, select the Enable 
full-screen mode switch 
check box, as shown in 
the following screen shot 

 
Troubleshooting Audio 

·  If you can see the video but have no audio Check the volume dial on your external 
speakers 

·  Check your volume control on the computer 
·  If using a projector, do you have an audio cable connecting the projector and 

computer? 
·  If using a projector, check the volume control on the projector 

 
 

Troubleshooting Closed Captioning 
If you can see the video but do see the close captioning: 
 

1. First verify that you downloaded the closed captioning file in addition to the video 
file. You would have clicked on the closed captioning symbol by the video title. 

2. Verify that the closed captioning option is turned on in Windows Media player. For 
Windows Media Player 10, Click the Play Menu and choose "Captions and Subtitles" 
and select "On if available." 

3. When you download the closed captioning file, in the download dialogue box, click 
the drop down arrow by "Save as type" and choose "All files" to ensure the file saves 
with the extension .smi. By default the computer may try to save the closed 
captioning file as an html file.  

4. Make sure both the video file and closed captioning are located together, either in the 
same folder or both on your desktop.  
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Click the My Account link in the top right corner to access: 

·  Your Profile: here you can change your password 
·  My Preferences: here you can subscribe to their newsletter 
·  My Homepage 
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